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About 2,760,000,000 results (0.33 seconds)

Android

https://www.android.com/ ~

See what's new with Andreld - from phones to watches and more. Visit the official site to explore and
learn.

Android Phones - 8.0 Oreo - Android One - Go edition
You visited this page on 3/26/18.

Android (operating system) - Wikipedia
https://en.wikipedia.org/wiki/Android_(operating_system) ~

Andreid is a mobile cperating system developed by Google, based on a modified version of the Linux
kermel and other open source software and designed primarily for touchscreen mobile devices such as

smartphones and tablets. In addition, Google has further developed Android TV for televisions,
Android Auto for cars, ...
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Android (operating system)

From Wikipedia, the free encyclopedia

For other things called "android", see Android (disambiguation).

Android is a mobile operating system developed by Google, based on a modified
version of the Linux kernel and other open source software and designed
primarily for touchscreen mobile devices such as smartphones and tablets. In
addition, Google has further developed Android TV for televisions, Android Auto
for cars, and Wear OS for wrist watches, each with a specialized user interface.
Variants of Android are also used on game consoles, digital cameras, PCs and

other electronics.
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android

Developer

Written in
os family
Working state

Source model

Initial release

Latest release

Latest preview

Marketing target

Available in

Package manager

Platforms

Kernel type

Userland

Default user interface

License

Official website

Google

Open Handset Alliance

Java (UI), C (core), C++ and morell]
Unix-like

Current

Open source (most devices include
proprietary components, such as
Google Play}

September 23, 2008; 9 years agu[Z]
8.1.0 "Oreo” [ December 5, 2017; 3
months ago

Android P/ March 7, 2018; 20 days
agol?!

Smartphones, tablet computers.
smartTVs (Android Tv), Android
Auto and smartwatches (Wear 05)
100+ languages!?

APK (primarily through Google Play;
installation of APKs also possible
locally or from alternative sources
such as F-Droid)

32- and 64-bit ARM, x86, x86-64,
MIPS and MIPSGE4

Monolithic (modified Linux kernel)

Bionic libc,[3] mksh shell,[®] Toybox
as core utilities beginning with
Android 6.0,[71[8] previously native
core utilities with a few from
NetBsDI1[10]

Graphical (multi-touch)

Apache License 2.0
GMU GPL v2 for the Linux kernel
modifications[11]

android.com &



https://developer.android.com/

Android Developers

https://developer.android.com/index.html| -

The official site for Andreid developers. Provides the Android SDK and documentation for app

developers and designers.

Develop Apps
Guides - Download Android Studio -
Android Design - Distribute - ...

Developer Guides
Welcome to the Android developer
guides. The documents listed in ...

Android Design
Android uses a new design metaphor
inspired by paper and ...

More results from android.com »

Download Android Studio
Download the official Android IDE and
developer tools to build ...

Google Play Console

Succey =
quality. relopers DESIGN DEVELOP  DISTRIBUTE

< Guides Develop > Guides » Build Your First App

Create an Android Project

Introduction This lesson shows you how to create a new Android project with Android Studio and descrit
Build Your First App - First, be sure you have installed the latest version of Android Studio. Download Android Studio here
D 1. In the Welcome to Android Studio window, click Start a new Android Studio project.

Run Your App L Welcome to Android Studio

Build a Simple User Interface

Start Another Activity

App Fundamentals

App Resources v
App Manifest File v
App Permissions v
Devices

Device Compatibility hd
Wear =

Or if you have a project opened, select File > New Project.



https://source.android.com

Py
I‘l Source Setup Security Porting Tuning Compatibility > Q Search GOTO CODE

Android unites the world! Use the open

source Android operating system to power GET SOURCE

your device.

8.7 interfaces and Securing Android is Get compatible, get
architecture essential apps

Port the latest Android platform Find out how the Android security Offer a consistent experience with
using simple HIDL interfaces to program works and learn how to other Android-powered devices and
create compelling devices for your implement the latest features. get the ability to include more
customers. apps.

LEARN TREBLE IMPLEMENT SECURITY TEST DEVICES

About the Android Open Source Project

Android is an open source software stack for a wide range of mobile devices and a
corresponding open source project led by Google. This site and the Android Open
Source Project (AOSP) repository offer the information and source code you need to
create custom variants of the Android stack, port devices and accessories to the
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Training
https://developers.google.com/training/android/

F
I'l Source Setup Security Porting Tuning Compatibility > Q, Search GO TO CODE

Android unites the world! Use the open

source Android operating system to power GET SOURCE

your device.

8.1 interfaces and Securing Android is Get compatible, get
architecture essential apps

Port the latest Android platform Find out how the Android security Offer a consistent experience with
using simple HIDL interfaces to program works and learn how to other Android-powered devices and
create compelling devices for your implement the latest features. get the ability to include more
customers. apps.

LEARN TREBLE IMPLEMENT SECURITY TEST DEVICES

About the Android Open Source Project

Android is an open source software stack for a wide range of mobile devices and a
corresponding open source project led by Google. This site and the Android Open
Source Project (AOSP) repository offer the information and source code you need to
create custom variants of the Android stack, port devices and accessories to the

C o oo e




https://www.tutorialspoint.com/an

° . 5| ‘ &
|\ tutorials
= MPLYEASYLEARNINEG -
#HOME <« Q/A .5 LIBRARY [EVIDEOS & TUTORS
@® Previous Page Next Page @

TR
H
0
FHHEL e

@ Android - Home

@ Android - Overview

@ Android - Environment Setup
@ Android - Architecture

@ Android - Application Components
@ Android - Hello World Example
@ Android - Resources

@ Android - Activities

@ Android - Services

@ Android - Broadcast Receivers
@ Android - Content Providers

@ Android - Fragments

@ Android - Intents/Filters

Android Tutorial

PDF Version [ Resources Il Job Search & Discussion

Android is an open source and Linux-based operating system for mobile
devices such as smartphones and tablet computers. Android was developed by
the Open Handset Alliance, led by Google, and other companies. This tutorial
will teach you basic Android programming and will also take you through some
advance concepts related to Android application development.

Audience

This tutorial has been prepared for the beginners to help them understand
basic Android programming. After completing this tutorial you will find yourself
at a moderate level of expertise in Android programming from where you can
take yourself to next levels.

Prerequisites

Android programming is based on Java programming language so if you have
basic understanding on Java programming then it will be a fun to learn Android
application development.

@® Previous Page &= Print Next Page @

Advertisements

droid



History

2003 2005 2010 2014
Startup.. bought by Nexus Android TV

Wear OS

Google phone ’

androidauto



Architecture Overview
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Core Concept 1 .






Base Linux Kernel Security

System User Account (uid/gid)
All app files are protected by unix chmod

All process run with current uid

Security Permission checked in System Calls
= standard kernel linux security

“Root” user O can do everything ...
Only Android low-level services run as root



1 Running App = 1 Process
(Linux JVM)

Start App ) - — GL?CE‘CU”APP Exit
Kill App



Adb Shell .. PS

arnaud@arn:~fAndroid/SdkS ./platform-tools/adb shell

shell@va2siae:/ %

shell@v2510:/ 5 ps
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NAME

/init
kthreadd
ksoftirgd/e
kworker /0:0H
migration/o
rcu_preempt
rcu_bh
rcu_sched
watchdog/e
watchdog/1
migration/1
ksoftirgd/1
kworkerf1:0
kworker/1:0H
watchdog/2
migration/2
ksoftirqgd/2
kworker/2:0
kworker /2:0H
watchdog/3
migration/3
ksoftirgd/3
kworker/3:0
kworker/3:0H
khelper
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Sample User App (Calculator)

/sbin/adbd
com.android.gallery3d
com.android.contacts
com.ape.calculator2
Jsystem/bin/sh
kworker fug:2

kworker fug:4

ps

4700 200 poll _sched 00000880
966444 15252 SyS_epoll 00000000
655600 26272 SyS _epoll 00000000
656132 30400 SyS epoll 00000000
1984 828 sigsuspend bé6e636cc
worker_thr 80000000

worker thr 80000000

@ b6dceoze

Calculator
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UID = u0_al0

_h311@V251ﬂ:f5yStENfahb 5 1s

peCalculator

peMyosVersion om.ape.filemanager
peResetUserData om.ape.launcher3
peSaletracker om.ape. led
peSystemUpdate om.ape.music

peTDrch ‘ om.ape.myseneschal
pnSettingsPlugin

. /ApeCalculator.apk

. foat

.foat/arm
oat/arm/ApeCalculator.odex




P
1 Installed App = 1 UID 'W'

Install 1 App => create a new UID !

Files owned by 1 App => files owned by UID

=

All Apps (Files) are ISOLATED

1 ﬁ 4
Files1

|
Files?




AFTTTTA
NO “Root” access i

Apps are installed by “apk” / MarketStore
... Similar to “sudo apt-get install ”

BUT

- forcing a new uid/gid for each app
- apps (files) are not owned to “root”
- no command “sudo”, no root acess

No apps can be root, only by jailbreaking your phone



Installlng App = Accepting “Manifest”
. Permissions
/

Google Play Each App as a “Manifest” Permission required files
When You install = You accept permissions

CIAN

©




Core Concept 2



Communications between Apps

Communication between Apps
= Using IPC Binder messages (service)




Permissions + Communications
between Apps

IPC Binder messages (service)
+ Permissions (Manifest file per App)




Apps Isolations / Data

Data Between Apps

L

4 l b Y

SyStem Data | And’roid, OS Permissions Check ]

==

Types of Sensitive User Data




Core Concept 3 : Intent

— — m—

INTENT  ACTIONS RESULTS

Your INTENT influences your ACTIONS
which influences your RESULTS.




Manifest — Intent Capabillities

2 B 5

Intent Filter => Action1 Intent Filter => Action2
ﬁ‘. (4) Result 1
(1) Intent I (2) Choose
(3) Result




Manifest — Intent Filter

<?xml version="1.0" encoding="utf-8"7>

es/android"™

<manifest xmlns:android="http://schemas.android.com/apk/r
package="com. example . myapgr

ication” =

<application
android:allowBackup="trus"
android:icon="@drawakble/ic launcher"

<activity
android:name="com.example.myapplication.MainfActivity"”
android:label="

<intent-filter>
£action android:name="android.intent.action.MAIN" />
<category android:name="android.intent.categeory.LAUNCHER" />
</intent-filter>

<factivity>

</application>
</manifest>



Core Concept 3 : RAM
Start / Kill / Resume App




Multiple Activities — Small RAM ...




Activities Stack & Recent

BACK HOME  RECENTS LA AEAR 1| b

ﬂ Apps & Games X

drupe )

All contacts & communication in one place

[ TR R RN

APPS & GAMES ENTERTAINMENT

TOFEHARTS




Activities Stack
(Open Modal Dialog.. Return)

Open Activity2 For Result Open Activity3 For Resul
example: example:

take photo send.. select Contact

=> open “Photo” application => open “Contact” application

= I o
Data(?) Data(3)



Activity Memento

Run Save Memento
. live data

- App -

Kill App

ResumeT
(re)Start App



Activity State Diagram

Paused

<process killed> <process killed>

Destroyed



Visible Activity State Diagram ...

= onCreateAndPreparetaDisplay()

L
| User navigates l
‘ back to the
___actvity onvisiblel) B onPrepareToDisplay()

l f
Process is . .
 killed onBeginlnteraction() |

.

Activity is [ The activity
running | comes to the

|_foreground
|' Another activity comes |
in frant of the achivity
l The activity
Other applications _ comes to the
need mamory onPauselnteraction() _foreground

(_The activity is no longer visible )

onlnvisible()

l

onDestroy()

i

Activity is
shut down
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Core Concept : Framework / APIs



HAL = Hardware Abstraction Layer

https://source.android.com/devices/architecture/hal

Hardware Abstraction Layer (HAL)

A HAL defines a standard interface for hardware vendors to implement, which enables Android to be agnostic about

lower-level driver implementations. Using a HAL allows you to implement functionality without affecting or modifying the

higher level system. HAL implementations are packaged into modules and loaded by the Android system at the
appropriate time.

)straction Layer (HA




Kernel < HAL < API

APPLICATION FRAMEWORK

BINDER IPC PROXIES
ANDROID SYSTEM SERVICES
MEDIA SERVER SYSTEM SERVER

AudioFlinger Search Service
Camera Service Activity Manager
MediaPlayer Service Window Manager
Other Media Services D’tl"ier&&;h:;ir:gi?;wces

Camera HAL Audio HAL Graphics HAL Other HALs

c Ori Audio Driver Displav Dri
amera Driver (ALSA, 0SS, etc.) Isplay Lirvers Other Drivers




Example: Audio

APPLICATION FRAMEWORK

Media Player App

android.media.*

Media Recorder App

frameworks/base/core/jni
frameworks/base/media/)ni

android. media_*.cpp

NATIVE FRAMEWORK

frameworks/av/media/libmedia

AudioRecord.cpp
AudioTrack.cpp

/ Other non-binder sources

< EINDER IPC PROXIES

frameworks/av/media/libmedia

lAudioRecord.cpp
lAudioTrack.cpp
lAudioFlinger.cpp

|binder.cpp k]

K- Binder w
MEDIA SERVER

framewarks/av/services/audioflinger

AudioPolicy Service

2

\

AudioFlinger Service

device/vendor/product/audio

Audio HAL Implementation

ALSASOSS/Custom Driver




Core Concept
APl — Services



APls ... (current APl level=27)

https://developer.android.com/reference/

s
I Developers DESIGN DEVELOP DISTRIBUTE Q, search [B pLAY C

< Reference

Package Index

These are the APl packages. See all API classes.

Android Platform

Class Index
Package Index
~ android
~ android.accessibilityservice
~ android.accounts
~ android.animation
~ android.annotation
~ android.app
~ android.app.admin
~ android.app.assist
~ android.app.backup
~ android.app.job
~ android.app.slice
~ android.app.usage
~ android.appwidget
~ android.bluetooth

android Contains resource classes used by applications included in the platform and defines application
permissions for system features.

android.accessibilityservice The classes in this package are used for development of accessibility service that provide alternative or

augmented feedback to the user.
android.accounts

android.animation These classes provide functionality for the property animation system, which allows you to animate object
properties of any type. int, float, and hexadecimal color values are supported by default. You can
animate any other type by telling the system how to calculate the values for that given type with a custom
TypeEvaluator.

 android.bluetooth.le
~ android.companion
~ android.content

android.annotation

For more information, see the Animation guide.

* android.content.pm android.app Contains high-level classes encapsulating the overall Android application model.
~ android.content.res
~ android.database android.app.admin Provides device administration features at the system level, allowing you to create security-aware

~ android.database sqglite

~ android.drm

~ android.gesture

~ android.graphics

~ android.graphics.drawable
~ android.graphics.drawable.shapes
~ android.graphics.fonts

~ android.graphics.pdf

~ android hardware

i IN 2 AT Car e device or upgrades to a new Android-powered device, all applications that have enabled backup can restore
« android.hardware.camera2.params

~ android.hardware.display

~ android.hardware fingerprint

~ android.hardware.input

+ android hardware.usb android.app.job

applications that are useful in enterprise settings, in which IT professionals require rich control over
employee devices.

For more information, see the Device Administration guide.

android.app.assist

android.app.backup Contains the backup and restore functionality available to applications. If a user wipes the data on their

the user's previous data when the application is reinstalled.

For more information, see the Data Backup guide.




Example API : Text To Speech

https://developer.android.com/reference/android/speech/tts/TextToSpeech.html

=
l'l Developers DESIGN DEVELOP DISTRIBUTE

TEXLIUDpPEE

¢ Reference The constructor for the TextToSpeech class, using the default TTS engine.

TextToSpeech({Context context, TextToSpeech.OnInitlListener listener, String engine)
Android Platform ~ AP: P ~ The constructor for the TextToSpeech class, using the given TTS engine.

~ android.service notification

* android.service.quicksettings Public methods
~ android.service.restrictions
~ android.service textservice int addEarcon(5tring earcon, String packagename, int resourceld)
~ android.service voice
~ android.service.vr

~ android.service wallpaper int addEarcon(String earcon, String filename)

N andm?d'SpeeCh This method was deprecated in APl level 21. As of APl level 21, replaced by addEarcon(String, File).
~ android.speech.tts

Adds a mapping between a string of text and a sound resource in a package.

Overview int addEarcon(5tring earcon, File Tile)
« Interfaces ) )
~ Classes Adds a mapping between a string of text and a sound file.
SynthesisRequest i ) )
TextToSpeech int addSpeech(CharSequence text, File file)
TextToSpeech Engine Adds a mapping between a CharSequence (may be spanned with TtsSpans and a sound file.
TextToSpeech.Enginelnfo
TextToSpeechService int addSpeech(String text, S5tring packagename, int resourceId)
UtteranceProgressListener Adds a mapping between a string of text and a sound resource in a package.
Voice
 android.system int addSpeech(CharSequence text, String packagename, int resourceld)
+ android telecom Adds a mapping between a CharSequence (may be spanned with TtsSpans) of text and a sound resource
~ android.telephony in a package
~ android.telephony.cdma P ge.
LR T TTE int addSpeech(5tring text, String Tilename)

+ android.telephony.gsm . .
e T Adds a mapping between a string of text and a sound file.

+ android.test

) boolean areDefaultsEnforced()
~ android.test.mock
 android.test suitebuilder Checks whether the user's settings should override settings requested by the calling application.
~ android.test.suitebuilder.annotation
- android.text Set<lLocale= getAvailablelanguages()
+ android.text format Query the engine about the set of available languages.
~ android.text.method
~ android.text style String getDefaultEngine()
* android text.util Gets the package name of the default speech synthesis engine.
~ android.transition
~ android.util Locale getDefaultlanguage()

« android.view Thic meathed wae donraratard in AD lowal 71 Ao of AD loral 1 1106 mnt MoaE ot t10nsmnd 1 el moad e



Example TTS Code ..

TextToSpeech tts =
new TextToSpeech(getApplicationContext(),
new TextToSpeech.OnlnitListener() {
@Override
public void onlnit(int status) {
if(status !'= TextToSpeech.ERROR) {
tl.setLanguage(Locale.UK);

}
}
D;

String toSpeak = “Hello Android”;

tts.speak(toSpeak, TextToSpeech.QUEUE_FLUSH, null);



Core Concept
Services / Job APl — No Threads



Core Concept : Ul

Resources
+ Layouts
+ Components

+ Fragments
+ ...



Defining Ul Resources

=?¥ml version="1.0" encoding="utf-8"7=

. <resources=
Slm ple Resou rces <color name="red"=#f00</color=
<color name="highlight">@color/red</color>
</resources>

MyProject/

sre/ Layout Resources
MyActivity.java InJava:R.layout.filename
ress ,
drawahles In XML: @[ package: ]layout/filename
graphic.png
layout/ SYNTAX:
maim.xml
info.xml
mipmap/ <?¥ml version="1.8" encoding="utf-8"7=
icon.png <ViewGroup
values/ xmlns:android="http://schemas.android.com/apk/res/android"

strings.xml android:id="@[+] [package:]lid/resource_name"

android:layout_height=["dimension" | "match_parent" | "wrap_content"]
android: layout_width=["dimension" | "match_parent" | "wrap_content"]
[ViewGroup-specific attributes] =
<View
android:id="@[+] [package:]id/resource_name"
android: layout_height=["dimension" | "match_parent" | "wrap_content"]
android: layout_width=["dimension" | "match_parent" | "wrap_content"]

[View-specific attributes] =
<requestFocus/>

</View=

<ViewGroup =
<View /=

</ViewGroup=

<include layout="@layout/layout_ resource"/=

</ViewGroup=



Using Resources in Java

[<package name>.]R.<resource_type>.<resource name>

// Load a background for the current screen from a drawable resource
getWindow( ).setBackgroundDrawableResource(R.drawable.my_background_image) ;

£/ Set the Activity title by getting a string from the Resources object, because
//  this method requires a CharSequence rather thanm a resource ID
getWindow( ) .setTitle(getResources().getText(R.string.main_title));

/f Load a custom layout for the current screen
setContentView(R.layout.main_screen);

f// S5et a slide in animation by getting anm Animation Trom the Resources object
mElipper.setInAnimation{AnimationUtils.loadAnimation(this,
R.anim. hyperspace_in));

f/ S5et the text on a TextView object using a resource ID
TextView msgTextView = (TextView) findViewById(R.id.msg);
msgTextView.setText(R.string.hello_message);



Using Resources in Xml

<Button
android:layout_width="Till_parent"
android:layout_height="wrap_content"
android: text="@string/submit" /=

Syntax

Here is the syntax to reference a resource in an XML resource:

@[<package_name>:]<resource_type=/<resource_name:




Ul Layouts

e

Ftalaﬂrauynut‘

e |

" Lineartayout. ' LinearLayout ' LinearLayout. “'-,
et mi“"’lﬂﬂ'__/ Nl dmn
View 'ﬂa'w View
/' RelativeLayout. \- ‘( Relativelayout. | | RelativeLayout.
' LayoutParam . LayoutParam . LayoutParam

<?xml version="1.0" encoding="utf-&"?%>
<LinearLayout xmlns:android="http:/
android:layout width="fill parent"
a:d:nid:Layn:t_ieig*t="fiLL

android:orientati

/schemas.android.com/apk/r
parent”

on="vertical®™ >

«TextView android:id="@+id/text”
a:d:nid:LayD:t_w;dt'= :ap_:n:te:t"
android:layout height="wrap content"
android:text="This is a TextView" />

<Button android:id="@+id/button”
android:layout width="wrap content™
android:layout height="wrap content"

=

android:text="This is a Button" />

<!-- More GUI components go here -—->

<fLinearLayout>

3!:.

ndroid"”



Ul Fragments

Selecting an item
updates Fragment B

Activity A contains
Fragment A and Fragment B

Hanaset

Selecting an item

starts Activity B

 Activity A contains Activity B contains

Fragmeant A Fragment B



Questions
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